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Software 3D LUT Creator is delivered "as is". Manufacturer does not guarantee changes or 
additions to the software on the User demand.

Manufacturer is not liable for any damages, direct or indirect, caused to User due to the incorrect 
operation or operation by untrained personnel Software or in cases where the damage was caused 
by a malfunction in the equipment.

Manufacturer reserves the right to make changes to any component of the Software without notice 
to the User or mention of this in this manual.

The text of this manual is protected by copyright laws. User is forbidden to reproduce, modify, or 
distribute the text of the manual (or part thereof) without written permission.

Program Website: http://3dlutcreator.com/
Official Russian-speaking community: http://vk.com/3dlutcreator
Official international community: http://www.facebook.com/groups/3dlutcreator

For all questions, please contact: support@3dlutcreator.ru

May 1, 2015
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Program interface

Tabs
Volume — channel volume
Channels — channel mixer
A/B — main color grid
C/L – colour/lightness grid
Curves – curves tab
2D Curves – 2D curves tab
Mask – mask tab

Keyboard symbols

Ctrl (Windows) = Cmd (Mac OS) – we will use Ctrl(Cmd);
Alt (Windows) = Option (Mac OS) – we will simply use Alt.
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Main menu and buttons
File                                  

Open image… – load image in program.
Load next image in folder – load the following file 
from the folder where last image was loaded.
Load previous image in folder – load the previous file 
from the folder where last image was loaded.
Load reference image – load reference image for 
curves import.
Save Image – save edited image (to the folder where it 
was loaded).
Save Image As… – save edited image under a new 
name and / or in the new format.
Import image from Photoshop – import the image 
from Photoshop.
Batch processing… – open images batch processing 
dialog.
New preset (Reset all) – reset all image settings to the 
original settings (mixer, grid, slider bar, curves, etc.). 
Load preset… – load preset with all image settings. 
Save preset… – save preset with all image settings: mixer, grid, slider bar, curves, etc.
Export 3DLUT File – save 3DLUT-file.
Send 3DLUT to Photoshop – load 3DLUT to Photoshop.
Import curves from file – analyse image and extract curves from it. You can do the same 
and drag-and-drop image onto the curves area (drag-and-drop works only on Windows, on 
Mac OS use menu).

Photoshop diagnostics – check of the presence of activated versions of Photoshop in the 
system.

Color Management – colour management:
Automatic monitor color profile – automatic loading of monitor CMS profile;
Load monitor color profile – load the color profile of the device. It is necessary only 
for viewing of the image (it is necessary to do, if you use the monitor with a wide color 
gamut, for example, Eizo ColourEdge or Nec PA241W);
Discard monitor color profile – reset the previously uploaded colour profile. It takes 
the monitor profile as a standard sRGB, however, the image profile is still used;
Disable CMS – turn off the colour management completely. In order to remove the 
checkbox, you have to switch back to Discard monitor color profile or Automatic 
monitor color profile. 

Preferences – program settings:
Save 3DLUT files to – select a folder to save LUT file: Image folder – the folder where 
image was loaded; Custom folder – the folder specified by user; Last used folder – the 
folder that was used last.
JPEG Save quality – select the compression quality to save .jpg files.
RAW Color space – color space for decoding RAW files when opened. 
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LibRaw demosaic – choose demosaic
(interpolation of Bayer matrix) for 
decoding RAW files when opened.
LibRaw Highlight – choose LibRaw
algorithm to restore highlights.
Picker area – coverage area in pixels for 
the eyedropper tool.
Default grid size – A/B and C/L grid 
dimension when the program starts.
Default Save type – default type for 
saving 3DLUT file.
3DLUT Size – dimension of saving
3DLUT file: the number of points on each 
side of the three-dimensional cube.
CMS Intent – color conversion method beyond the boundaries of the coverage profile.
Background color – choose background color for image area. 
Curves Auto BW – method of working [Auto Black] and [Auto White] buttons on the Curves tab.
Photoshop connection – for those who have multiple versions of Photoshop, you can 
choose which of them the program will work.
Photoshop or After Effects path – select program folder which 3D LUT Creator will 
work if you select Custom Adobe Photoshop or Custom Adobe After Effects. You must 
specify a file path to Photoshop.exe or AfterFX.exe files.
Always save LUT with size 64 – always maintain (and send to Adobe Photoshop) 64 
LUT size (regardless of the setting 3DLUT Size) for more accurate color separation.
Save Backup file – save original image.
Close conformation – confirm the closure of the program.
Border color planes – show color plane only on borders of A/B and C/L grids.
Clip to white – protection white balance from clipping (see sliders: Temp. and Tint).
Square A/B grids – proportions of the color plane on A/B tab are always equal to 1:1.

Exit – close the program.

Edit

Undo – undo the last action. You can undo 
several actions at a time.
Redo – redo the last action after undo.
The names of these items in the menu will look 
different depending on the last action.

Paste image – paste image from the clipboard.
Paste image as reference – paste image from the 
clipboard as a reference image.
Select All – select all grid nodes.
Inverse selection – inverse grid nodes selection.
Deselect – deselect all grid nodes.
Pin All – make all grid nodes active (see. grid 
chapter).
Edit luminance curve – L-channel curve (from 
LAB color space).
Edit master curve – RGB common curve.
Edit Red curve – R-channel curve.
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Edit Green curve – G-channel curve.
Edit Blue curve – B-channel curve.
Randomize curves – random curves setting.
Select next Ext. LUT – select next external LUT file in folder.
Select previous Ext. LUT – select previous external LUT file in folder.
Compile LUT and load it as external LUT – compile current LUT and load it to the 
external LUT section. Current LUT is not saved on the disk.
Swap current and external LUT – move current LUT to the external LUT section and apply 
external LUT. Current LUT is not saved on the disc.
Clear color watches – remove all color from the color watches.
Make Color matrix for color checker – automatically calibrate the color of the X-Rite 
ColorChecker target via the channel mixer. You should first add all of the target color 
samples with the analysis window. Colors must be added from brown, beige, blue, and so on 
by the target lines, ending with neutral.

Image

Turn CCW – rotate the image counter-clockwise.
Turn CW – rotate the image clockwise.
Use Alpha Channel – apply a correction in 
accordance with the Alpha Channel of an image.
When you import images from Photoshop with Shift 
(Shift+Image from PS button) selection/layer mask 
saves in the Alpha Channel.
Fill Alpha Channel – fill Alpha Channel with white color (reset mask in Alpha Channel).
Snapshot processed image as reference – use edited image as reference.
Process image with current LUT and reset settings – apply LUT to the image and reset 
LUT settings.
Assign color profile – assign a new color profile 
image without changing the image.
Convert to profile – convert the image to a new 
color profile with color retention.

View
Zoom full – fit the image onto the screen.
Zoom 1:1 – original image size.
Zoom in
Zoom out
Switch picker format – switch color model 
numbers for color measurement.
ColorCheker points – show the grid points which 
correspond to the colors of the X-Rite ColorChecker
target.
Color plane – enable/disable the color plane in the 
A/B and C/L grids.
A/B and C/L color distribution – show the 
distribution of the original colors on the grid. The 
more tones of color on the image, the brighter the 
point on the grid.
A/B and C/L Show start points – show the initial 
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positions of grids nodes using the red lines.
Show mask preview – show mask for use 3DLUT (if enabled).
Compare – compare the original image and the edited version side by side in one window:

Compare vertical – compare the original image and the edited version side by side or 
one above the other. Switching operates as two images and for image divided into two 
parts.
Split compare – show the original image and result together, the picture is divided in 
half.
Swap Before/After – swap views before/after.

Show Before – show the original image (if Compare off).
Show Reference – show reference image.
Show clip warnings – show highlights and shadows clipping.
Show separate channels – each channel image preview:

RGB Composite;
Red – Red channel;
Green – Green channel;
Blue – Blue channel;
Grayscale – Grayscale image.
Blacks/Whites – show blacks and whites areas of the image to control details.

Update histograms – update the distribution of the current tab.
Load proofing profile – load an external color profile of the output device (printer) to view 
color fidelity when displaying.
Soft proofing – enable/disable viewing the simulation output device.
Gamut warning – show colors that go beyond the boundaries of the external color profile.

Window
Analyzer windows – show Analyzer windows 
(histogram, etc.).
Historam – histogram.
Waveform – graphical display of the color of the 
image image.
Vectorscope – vectroscope.
Averages – averaged color samplers.
Watches – color measurements.
Color sort – sorting images according to the 
brightness of pixels and displaying them in a gradient.
Color circle – color circle to see LUT work.
Separate image window – show the image in a 
separate window. It is comfortable to work on two 
monitors.
History – open history window.
Next tab – move to the next tab.
Prev. tab – move to the previous tab.
Next window – move to the next window.
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Help
Visit site… – go to the official website of the program.
Register… – register the program. After successful registration label 
will change to Registered!
About – about the program. You can check the version of your 
program.

Buttons

[Load Image] – load image from disk.
[Save 3DLUT] – save 3DLUT file on the 
disk.
[Save image] – save image.
[Image from PS] – load an image from Photoshop. If you have Photoshop open with the 
image, it is taken directly from there. If it contains layers, the program is loaded composite 
image. File imported from Photoshop can be 8-bit and 16-bit; in RGB, CMYK or Grayscale 
color space (Lab is not supported).
[LUT to PS] – send the 3DLUT to open image in Photoshop as an adjustment layer Color 
Lookup. 
[Paste] – paste image from clipboard.
[Compare] – show the original and the edited image. Right click on the button changes the 
display layout (near or one above the other).

Note

§ A saved image or grid can be opened by simply dragging the file to the image area.
§ Reload LUT from the program to Photoshop does not create additional layers and replaces the 

current LUT-layer ifs this layer is not renamed and was active. Otherwise, a new layer is created. 
Mask and layer properties are saved.

§ If you sent LUT to Photoshop (LUT to PS) followed load back from the Photoshop image 
(Image from PS), then as the source image will get the picture, which is already applied to the 
LUT. 
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Batch processing dialog

Process folder – select folder with 
files for batch processing.
Subfolders – include subfolders.
Save to – select a folder to save edited 
files: Same folder – same folder as 
originals; Subfolder – save to 
subfolder; Specified folder – specify 
folder for saving.
Prefix, Postfix – add Prefix or Postfix 
to the name of saving file.
Skip existing output files (don’t
overwrite) – skip edited files saving 
if they have the same names.

Target format – select format for 
edited files.
Process with LUT – process selected 
files with current LUT.

Buttons

Clear – clear all the files from batch list.
Add files… – add files to batch list.
Remove – remove the selected files from batch list.
Load batch… – load batch preset.
Save batch… – save batch preset.
Run – run batch processing.
Close – close batch processing dialog window.

If you select a folder with images for batch processing, the files in the batch list are automatically 
added.
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Formats and files

Supported formats:
image formats .png, .bmp, .jpeg, .tiff (8 and 16 bit; RGB, CMYK, monochrome);
Targa formats (.tga, .vda, .icb, .vst);
the program works with images in any color profile sRGB, AdobeRGB, and so on. etc;
images in LAB color space are not supported;
You can open the RAW camera images (.cr2, .nef, ...),
For normal display RAW you should choose Log-profile. Default is off.

Saving image formats:
.jpg file: selects the compression ratio in the program settings (default quality is 
100%);
.tiff file is saved always RGB 16 bit;
.png

Saving LUT-file:
.3dl (Photoshop);
.cube (Iridas, After Effects);
.csp (Cinespace32) – spline interpolation is used;
.png GPUImage;
.png Unity 3D (LUT size 16 and 32);
.png Amplify Color (LUT size 32).

Program preset file:
.luc – internal format of 3D LUT Creator that stores all the picture settings:

grid;
shadows and highlights settings;
sliders;
luma mode;
curves.

.lub – internal format of 3D LUT Creator that stores batch processing settings.
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Channels (channel mixer)

Channel mixer works the same as channel 
mixer in Photoshop. Channels tool receives 
RGB image channels by mixing original RGB 
channels in different proportions. On the 
screen there are three nodes to the red, blue 
and green sector. They indicate proportion of 
mixed RGB channels.  

Nodes position and mixing

· The brightness of the mixture is always 
normalized. For each of the three 
nodes the amount of channels equals 
100%.

· For nodes within the central triangle 
were used an ordinary mix and positive 
values of channels.

· Strictly along the border of the central 
triangle is a mixture of only two 
channels (third channel is always zero).

· Outside the central triangle there is 
used hard mix (channels can take a 
negative value).

Controls

· You can turn on/off Channels by clicking the switch at the Channels tab.
· – reset Channels to default settings.
· [Reset Exp.] – reset exposure compensation, which could appear after using the function 

Make color matrix. The average value of the nodes brightness is normalized;
· [Randomize] – random channels ratio in the mixer;
· [Inverse] –  inverse transformation;
· [Hue -/+], [Sat -/+] – simultaneous change of hue and saturation of the overall image;
· nodes can be moved using the arrow keys of the keyboard;
· it is possible to select two or three points, pulling the frame using the mouse (the selected 

nodes will move together);
· the movement of the mouse up/down with the pressed Shift – to change the point brightness 

and the overall image brightness;
· right click – to reset the brightness;
· double-click – to reset the node entirely;
· double-click on the digital display allows you to enter the desired number from the keypad.
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Volume (channel volume)

Volume tool mixes the brightness of separate 
RGB channels to the image brightness (RGB is 
multiplied by the proportion of [mixer 
brightness/original brightness]). As the name 
implies, it allows controlling the image details or 
volume. If the details of your image are not 
visible, they can be getting from the separate 
RGB channel. However, you should be careful, 
separate channels might contain a great number 
of noises. The channel mixer is applied to the 
image after the color balance (Temp. and Tint 
sliders), but before the grid application.

Nodes position and mixing

· If the node is in the centre of the triangle, but nothing happens – the image brightness does 
not change.

· If you put the node on the boundary of the centre triangle at the top of one of three angles, 
then the image brightness will be taken completely from red, blue or green channels.

· If you put the node within the centre triangle, then the brightness will depend on a simple 
channel mixer. The closer to the triangle centre, the less the image differs from the original 
one.

· Outside of the centre triangle, there is hard mix. Some of the channels get the negative 
values and start to obscure the image. The separate channels can gain the value more than
100%. 

· The sectors outside the central triangle specify the area, in which two channels become 
negative. The remaining channel has positive value more than 100%.

Controls

· Node can be moved using the arrow keys of the keyboard.
· The movement of the mouse up/down with the pressed Shift – to change the node 

brightness and the overall image brightness.
· Right click – to reset the brightness.
· Double-click – to reset node position.
· Double-right click – to reset the node entirely.
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Operating elements

· You can turn on/off Volume by clicking the switch at the Volume tab.
· Button resets the Volume to the initial state.
· Button [Make lightness curve] makes the curve Luminocity in order to make it possible to 

restore the brightness and contrast to the state before Volume (as far as possible). 
· Sliders Lighten and Darken regulate the image lightening and darkening. The default is the 

middle or 100%. If both slider bars are in the initial zero position, there is no effect on the 
image.

· Slider Gamma regulates the gamma range of effects. It differently redistributes the impact 
between lights and shadows. The gamma value may lie in the range from 1 to 4. The default 
gamma value for sRGB images is 2.4.

· Double-click on the digital display allows you to enter the desired number from the keypad.

Luma mode (brightness changing modes)

· Parallel – the parallel shift of RGB curves up or down.
· Star – RGB multiplication by the factor. The black point is not affected.
· Arc – to arch the curves in the arc up or down. The black and white points are not affected.
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A/B

Main grid and grid controls

The grid is the colors in LAB or any 
other selected space in drop down list 
Model. You can change the colors by 
moving the nodes of the grid, as well as 
change the brightness.

In the picture: white, grey and black 
color of the nodes represents the 
brightness of the nodes; large and small 
points – pinned and free nodes; node 
with white frame – selected node. 

Pinned and free nodes

· Free nodes move with pinned nodes.
· Position and brightness of free nodes depend on 

position and brightness of pinned nodes.
· Any attempt to edit, move, change the brightness of 

the node or simply click with the mouse – to make the 
node pinned.

Pinned  node is shown as a large point on the grid.
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Nodes selection

· You can select one node just clicking on it with the
mouse. Selected nodes were marked by small white 
boxes. 

· You can select several nodes pulling the frame on 
them with left-click.

· To select nodes individually click mouse with 
pressed Ctrl(Cmd) .

· If you want to move the selected node, you will 
move all the selected nodes at once.

· The brightness change and reset for the selected nodes are actuated 
simultaneously.

Controls

Nodes moving. You can move the nodes just using the mouse. You can move the 
selected node using the arrows of keyboard.

Nodes brightness. Pressing the key Shift and moving the mouse you can change the 
brightness of a single node and the corresponding color. The brightness is changed
moving up or down.

Node reset. The right-click returns the initial node state.  It resets the node positions, 
its brightness and makes it free node.

Double click – to reset the node to the initial position without removing its pin and 
changing the brightness.

Right-click while pressing Shift – to reset only the node brightness without changing 
its position.

Repulsion and contraction of the nodes. In the repulsion or contraction mode you 
can compress or expand the separate parts of the grid. In repulsion mode, click 
anywhere on the grid, and all nodes will be pushed aside. The repulsion and the 
contraction do not affect the free nodes. It may also seem that the moved nodes entail 
the active nodes connected with them, even if they are at the other end of the field. In 
fact, there are selected only pinned nodes, according to their initial positions.

Area of influence. Clicking on the node and pressing the button Alt, you can see the 
parts of the image, which this node affects. The node itself won't change. The 
viewing option of the area also works for several selected grid nodes. The same thing 
for the image, by clicking on the image and pressing the button Alt, you can see the 
area of color influence and the corresponding node.

Image. The grid nodes can be moved by dragging the points on the image itself. To 
do this, you should click on the desired colour of the image and move the mouse.
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The same way, with the pressed button Shift you can change the brightness.

White cross. If you move the mouse over the image, a white cross will indicate a 
specific color on the field with the grid. The cross itself indicates the original image 
color (after application of the sliders). The cross arrow indicates the new color after 
application of the grid. The nearest grid node is highlighted with the white box.

Grid control buttons

– normal mode. It lets you to move one node moving the mouse on the original 
image.
– dragging the colors on the original image – it moves four nodes of the grid.

– contraction mode. Click on the grid and it pulls the nearest nodes to the cursor 
(contraction of the color space).
– repulsion mode. Click on the grid and it pushes all the nodes around the cursor 
(expansion of the color space).
– color selection with the help of the frame on the original image, it chooses the 
appropriate nodes of the grid.
– add a new color to the analyzer window. Click the mouse on the image. It is 
unnecessary to open the analyzer window beforehand.

– image zoom control.

– Alpha Channel marquee selection.

Dragging the colors on the original image in the mode of one or four nodes resets the 
selected groups.

Indicators Hue/Sat shows the source and target saturation and hue for the selected node 
of the grid. To change the hue or saturation for the selected nodes of the grid you need to 
hover your mouse on the appropriate indicator and move mouse while holding the right 
button.

[Reset] – complete reset of the grid (or selected nodes only).
[Reset Sat] – saturation reset. It shifts the grid nodes in such way that the grid does not 
change the color saturation (eg. for Lab, there is put the original distance of the nodes from 
the grid centre, the brightness and angle are maintained).
[Reset Hue] – hue reset. It shifts the grid nodes in such way, that the grid does not change the 
hue (eg. for Lab, there is put the original distance of the nodes from the grid centre, the 
brightness and angle are maintained).

[Pin All] – when this option is switched on, all the grid nodes are considered to be pinned.
[Smooth] – grid smoothing. The attempts to allocate all the grid nodes a little bit more evenly. It 
performs the smoothing, but not the return of nodes to their initial position. In order to return the 
initial position of the grid (till the state Reset), pressing and holding this button will not work. Also, 
it does not affect the nodes on the grid boundary.
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L switch in order to choose the color space, the method of operation with color and brightness.

Add – RGB channels are shifted up or down in parallel. (To R, G, B there are added the same 
figures).
Multiply – the brightness is changed with the help of scaling of RGB channels, the black point 
is not changed (R, G, B are multiplied by a certain factor in order to achieve the necessary 
brightness).
Gamma – the brightness is changed with the help of curve arching up or down; the black and 
white points are not affected.

Grid Switch

4, 6, 8, 12, 16, 24, 32 – change the grid size trying to save its shape. If you do not want to increase 
the grid distortion or the number of nodes you can choose the size for switching with the multiple 
nodes. 

6C, 8C, 12C, 16C, 20C, 24C – change the grid type to Web mode.

Do not confuse the grid dimension and the size of LUT-file!
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Color Model Switch (color space for A/B and C/L grids)

Briefly on the abbreviations:

LAB – Lab color space. The tonality and saturation distribution passes via the channels A
(magenta-green) and B (yellow-blue).
M – vector length in RGB cube.
e – means that the colours close to black and white are extended according to their saturation. It 
is more consistent with the photographic color. Ideally, if the object is of one color, it will have 
the constant color values; they will have only different brightness. Without the extension, the 
colors close to black and white have very low saturation.
n – means the extended area of neutral colors.
XY – the point projections in RGB cube on the plane of equal brightness.
AB – the angles of the vector in RGB cube (not to be confused with Lab).

Color spaces
LAB – normal Lab space. It is fully consistent with Photoshop Lab space.
LABn – modified Lab space. It is the extended area of neutral colours and a little bit rotated 
axis for the better colour separation.
LXY – simplified Lab space. 

L – brightness; it coincides with the brightness in LAB space.
XY – also the point projections in RGB cube on the plane of equal brightness.

MXY – M - vector length in RGB cube.
XY – projection of colour point. The axis of the primary colours in MAB and MXY are 
located in such way, that it should be roughly equal to what we have in LAB, but there is 
no the full compliance.

MABe – M - vector length in RGB cube.
AB – the angles of the vector in RGB cube.

MXYe – same as MXY, but it has the extension in the black and white points.
SXYe – takes into account the gamma correction of sRGB profile.

S – brightness as the sum of R, G, B.
XY – also the point projections in RGB cube on the plane of equal brightness.

HSPn – HSP color space with extended area of neutral colours.
HSPne – HSP color space with extended area of neutral colors  as well as better division of 

light colors on the color shade.
HSP – HSP color space.
HSPe – HSP color space with better division of light colors on the color.
HSP3 – HSP color space with extended R, G and B areas.
HSP Itten – HSP color space with color representation as on the Itten color circle. 
YUV – it is used in the video data processing.

Y – brightness.
UV – color difference components.

CMYK – CMYK color space.

If you have changed the grid during the switch of the color space the color grid will not be 
changed for the new colors!
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Sliders

Click and press Ctrl(Cmd) to reset the slider bar to the original value. Double-click on numeric field 
allows entering the value with the help of keyboard. Eyedropper tool – to set the white balance 
(Temp., Tint) with a single image point. After its use it is better to switch it off.
Temp., Tint – the overall color balance. 
Saturation – the color saturation. 
Brightness, Contrast – work only with the image brightness.
Temp., Tint and Saturation are used before the grid application and all other tools, so set them in advance.

Temp. – the image temperature (warm, cold). It shifts all the shadows to blue and orange colours.
Tint – the image tint. It shifts all the shadows to purple or green tints.
A – auto white balance.

The similar parameters (Temp., Tint) can be used in RAW converter. Physically, the rebalancing is 
performed by channel scaling to RGB. I. e. the channels are divided or multiplied by some small 
factor. Any RAW converter in general does just the same. There is the flow chart below. If in the 
program settings, the option Clip to white is activated (enabled by default), then the flood control 
works there. I.e. if after multiplying one of the channels has achieved the maximum value the other 
channels are scaled additionally in order to maintain the required tint.

Brightness – increases or reduces the overall brightness. Makes a gamma curve, arches it up or down.
Contrast – increases or decreases the contrast. Makes the S-curve brightness in L channel.
Pivot – additional parameter contrast. Shifts to the right or to the left the point which sets S-curve.

Below there is shown the shape of the brightness and contrast curve, for the values of -100%, -50%, 
+50%, +100% in L channel (Lab).

   Brightness                                                           Contrast

Saturation – saturation works quite delicately. The value + 200% saves the substantial portion of 
hues, while in Photoshop in the case of 100% saturation increase, all hues are changed, regardless 
of the colour space. However, change the settings carefully, as the details in the brightest areas of 
the image suffer first of all.
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For comparison:

– initial color gradient

– 3D LUT Creator, saturation 200%

– Photoshop, saturation 100% in Lab color space

RAW-convertation parameters

Log – Log-profile choice for RAW-file. Default state is off.
Blacks, Whites – shadows and highlights adjustment.
Color recover – recovering of details from overbrights.

– choosing overbrights on the image. A – automatic search for overbrights.

Shadows and highlights

The control element is located directly over the grid. It allows making the selective effect on the 
image shadows or highlights. By default the grid affects the highlights and shadows simultaneously.

· turn off [Shadows] – if we do not want to change the shadows
· turn off [Highlights] – if we do not want to change the highlights
· [Double] turn on the separate toning for the highlights and shadows (double grid)

The slider adjusts the shadows and highlights depth which the program affects.

The effects on the frame, above or below the predetermined threshold, 
are not terminated, it decreases gradually. The effect curve is shown 
on the left. If we affect only on the shadows then to the position of the 
slider bar the effect is full, further it decreases and continues to decrease, 
disappearing only at the range border. Near the highlights or shadows 
(depending on what we have chosen) practically there is no effect and it 
doesn't become evident immediately, cos(x)=0
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Double grid

Button [Double] turn on two separate grids for the highlights and shadows.

Upper grid is for highlights, lower is for shadows of the image.
If the buttons [Shadows] or [Highlights] are off then one of these grids does not work.
If the button [Double] is off there is used the upper grid.
The grid nodes can be moved over the original image. Upper or bottom grid is automatically chosen 
depending on the colour brightness.

[Copy Down] – copy the upper grid down.
[Copy Up] – copy the lower grid up.
[Swap] – swap grids.

Simple actions with grid
In outer and corner nodes, there are the most vibrant colors. The central grid node has a neutral grey
color. You can fix the neutral colors or some separate color, so that they have not changed during 
the grid edition: 

You can give any color to neutral colors or change a particular tint:
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To shift the angular grid nodes closer to the centre in order to reduce the overall image saturation. 
Only after fixing the nodes around the central part in order to loosen only the most saturated colors.
To shift or expand the nodes around the central part of the grid in order to loosen or strengthen only 
poor saturated colors:

  

To shift one, two or three corners closer to the centre or to another angle in order to remove a
portion of the color from the image:

  

To expand or compress a separate range of shadows (you can use In, Out modes):

To tone the image entirely by moving all the angles to any particular place:
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C/Lgrid (color/lightness)

Two grids correspond to the two sections planes 
1+ and 2+ three-dimensional figures 
representing working color space (selected in 
the drop-down list Model). Brightness changes 
vertically. Hue and saturation change 
horizontally. Neutral pass through the middle 
grids downwards. Both sections of the plane 
can be rotated vertically around a central axis 
that is responsible for the neutrals (color box in 
the lower left corner of the tab).

Controls

Nodes movements, their selection and
brightness adjustment are the same as that of
A/B grid. 

Buttons

resets both grids (the rotation angle is saved).

[C/L Grids] enables/disables the effect of C/L grid.

[Reset Grid 1] and [Reset Grid 2] reset the color component of the upper or bottom grid.

[Smooth Grid 1] and [Smooth Grid 2] smooth the colour component of the upper or bottom grid.

[Reset Luma] reset the lightness component for both grids.

[Smooth Luma] smooths the brightness component for both grids.

[Smooth] smooths both grids.

[Pin All] pins all grid nodes.

[Pin Neutral] – pins all neutral nodes.

Grid chooses the number of grid nodes. Slider Axis angle chooses the rotation angle for the color 
component of the planes (brightness is not changes, the planes are always perpendicular). 
Eyedropper chooses the rotation so that the color is projected into the centre of the upper grid, and 
as far as possible from the centre of the bottom grid. The bottom projection passes through the
selected color and the upper one – perpendicularly. 

When you rotate the grid the positions of nodes are not recalculated. 



26

Curves

There are seven curves on the screen:

Luminance – brightness curve.

Sat/Luma – saturation curve (the dependence of 
the saturation on the brightness). Mid level –
saturation without changes. Up or down – to 
increase/decrease the saturation.

Sat/Sat – saturation curve (the dependence of the 
saturation on the saturation). It allows you to 
adjust saturation separately for low saturated 
colors, medium saturated and highly saturated 
colors.

Master – selecting curves mode:

R, G and B – separate RGB channels.

[Before/After] – use Master curves before or 
after RGB curves.

Curves modes:

Normal – common master RGB curve. It works the same way as in Photoshop: master 
curve duplicates RGB curves.

Uniform – complexity mode of master RGB curve. Master curve controls the brightness 
without affecting the color tones. 

Color – mode with protection the overall brightness. It works like the Color mode in 
Photoshop. 

CMYK – CMYK curves mode. Subtractive color system, the more colors, the darker image.
Master curve adjusts the black channel. At least paint the top right corner, the maximum - on 
the bottom left corner of the curve field. Color separation with a maximum substitution of 
colors by black paint (Maximum GCR). Neutral colors are completely contained in the black 
channel.

CMYK2 – CMYK curves mode 2. Color separation with less replacement of colors by 
black paint. For K curve the point of black and white coincide with the usual CMYK mode.
In other levels of luminance K curve bends up and adds a smaller amount of black paint.

RGBW – additive color system (as in the monitor). The more light, the brighter image.
Color separation on white channel (used to be master curve) and RGB channels (master 
curve adjusts the amount of white). Color separation with a maximum substitution of color 
by white paint.

RGBW2 – additive color system RGB. Color separation with no maximum substitution of 
white paint.
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The order of curves application

1. Luminance curve is used first of all.
2. Sat/Luma  curve (its impact depends on how you have changed the brightness).
3. Sat/Sat.
4. Master curve
5. RGB curves.

Curve histograms

Luminance – lightness histogram (made from L channel of Lab color space).

Sat/Luma – histogram shows the saturation in different ranges of lightness.

Sat/Sat – histogram shows the saturation in different ranges of saturation.

Master – brightness histogram after the application of the master RGB curve.

RGB – histogram of the separate RGB channels.

The position of the separate colors on the curves can be noticed just moving the cursor over the 
image.

Controls

· Alt +1,2,3,4,5 – choose Luminance, Master, R, G, B curves in order to put point on curve by 
clicking on the picture (if Photoshop opened it often blocks these shortcuts).

· Slider changes the effect of curves (by analogy with the degree of transparency of the layer).
· Left-click — to put or move the point on the curve.
· Right-click — to remove a point. Also it is possible to pull the point beyond the curve to 

remove it.
· The point on the curve can be moved with the help of arrows of keyboard (on Mac OS 

Shift +arrows).
· Choosing point on curve and pressing Enter – input exact position from keyboard.
· Alt +click and moving point – Elastic Curves mode.
· Clicking on the part of the curve and pressing Shift in order to straighten the part of the 

curve (if it is necessary to make a broken line).
· There is not required a exact pointing to the point. It is enough to get any part above or 

below the curve.
· +/- – going on points of the curve to the right/left.
· Button above the curve enables/disables the effect of the curve.
· Any attempt to change the curve turns on a button for its impact.
· Clicking the button above the curve and pressing Ctrl(Cmd) resets the curve to the original 

value.
· Clicking the button above the curve and pressing Shift smooths the curve.
· The point on the curve can be placed and moved just clicking on the image. Before this you 

have to choose one of the curves with the right mouse button (you can do it with the left one, 
but then there will be put a new point). The active curve is circled with the frame. Pressing
Shift+Ctrl(Cmd) you can put three points on RGB curves at once.

· J shows clipping in channels.
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Targeted adjustment tools

Targeted adjustment tools are used to change the mode of the curves adjustment.

Grey – to bring color to neutral one.

Exact – when you click on the image curves are bent so that the color under the pointer 
has become equal to the selected color on the color box.
Color – when you click on the image curves are bent so that the color under the pointer 
has become equal to the selected color on the color box but maintaining the original 
brightness.
Hue – when clicking on the image curves are bent so that the hue under the pointer has 
become equal to the hue of the selected color on the color box, but without changing the 
original saturation and luminance.
Saturation – when clicking on the image curves are bent so that the saturation under 
the pointer has become equal to the saturation of the selected color on the color box, but 
without changing the original hue and luminance.
Lumimance – when clicking on the image curves are bent so that the brightness under 
the pointer has become equal to the luminance of the selected color on the color box, 
but without changing the original hue and saturation.

If at the Curves tab choose Luminance, Hue or Saturation tool and with holding the Shift key 
pressed and move the mouse up/down on the image or Color Watch, then at the same time on 
all three RGB-curves point will be added that will change the only one color characteristic
(Luminance, Hue or Saturation).

In other modes there is color box. To choose a color for the color box you 
can click on it. This will open the palette window. You can either select the 
color or enter the numbers manually. Also, the color may be added from the 

image by clicking and holding down Alt button. Buttons [L-] and [L +] are used to 
increase or decrease the luminance of the selected color.
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Buttons

[Invert] turns the curve around the 
diagonal axis. I.e. transpose in 
order to reverse its effect. It should 
be noted that in the case of 
repeated pressing the curve is rapidly degraded (loses its accuracy).
[Smooth] smoothes RGB curves (does not delete the point and does not touch the outer points 
of the curves).
[M->RGB] extracts the master curve out of RGB and uses it again (the result depends on the 
method of curves extraction).
[Randomize] – random selection of RGB curves form.
[Auto Black] – automatic setting of the black point to RGB curves.
[Auto White] – automatic setting of the white point to RGB curves.
[De-grade] extracts the curves out of the reference image.
[Grade] – extracts the curves out of the reference image and applies to the editing image.
[Masked] – uses for De-grade analysis colors which get to the mask.
[Method] – method of curves extraction (button De-grade):

Average – it takes into account the proportion of colors, thus, if for example a lot of 
space is occupied by green and the face is small the skin tone can be spoiled;
MinMaxMid – it do not take into account the proportion of colors and takes into 
account hue variation of colors of each considered range of brightness, luminance ranges 
are selected without regard to brightness of coefficients R, G and B;
MinMaxMid 2 – it do not take into account the proportion of colors and colors variation 
in hue in each considered range of brightnesses;
MinMax – it does not account the proportion of colors but takes into account their 
brightness variation;
MinMaxAvg – it is calculated the average range of the maximum and minimum 
deviation to neutral colors for each channel;
Red, Green, Blue – as a monochrome base are used corresponding channels;
Equalize – aligns channel-by-channel the histogram to the plane and tries to lead a 
histogram of one image to the histogram of the other one.

The difference between Average and MinMax is in the way how the neutral colors are 
calculated:

Average – there is used the average color of all pixels present in the image. Therefore, 
the size of the color areas of the image is important.
MinMax – there is used the minimum and maximum values for each channel. It is given 
as neutral. Thus, the size of the color areas of the image is not important.

[Inverted import] takes into account the tonal range of the reference image during the curves 
extraction. I.e. it analyses two images: that which should be toned (it should be dragged into the 
area of image) and reference image (it should be dragged into the area of curves).
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Import curves from file

The program allows you to copy image toning from the picture that is provided as sample. It tries to 
copy the basic colors for different brightness of the image using RGB curves.

In the image area (2) you can drag the picture for edition. In curves area (1) you can drag the image-
sample for analysis and curves extraction (drag-and-drop works only on Windows, on Mac OS use 
menu File > Import curves from file). In curves area (1) you can also drag the preset of curves 
saved in Photoshop (.acv file).

In order to extract the curves program creates Auto Levels – the image-sample is stretched to the 
full range of highlights and shadows and then discolored. It is conventionally considered to be “the 
reference picture without edition”. Then program calculates the curves which return this stretched 
discolored image to the original position (of course there won't be a variety of colors, and the color 
will depend only on the brightness). Thus, we get the curves which are used for the edited image.

In order to copy the toning of the reference image it is enough to drag it to the area of the curves 
(1). Or open the sample through the menu: File > Import curves from file (do not forget to keep an 
eye on the condition of the buttons [Method] and [Inverted import]). The dragging of the image to 
the area of curves is equal to the uploading of the image and the button sequence: [De-grate] and 
[Transpose].

1 2
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2D Curves (projections of RGB cube)

The figure on the right 
shows RGB cube. 
Along the edges there 
are RGB axes. Across 
the diagonal of the 
cube there are neutral 
colors, i.e. the place 
where all three RGB 
components are equal 
to each other. 

In the tab 2D Curves there are used the side projections of RGB cube, which are rotated so that the 
axis of neutral colors passes vertically upwards. It is one of R, G, B axis and it lies horizontally, and 
is directed away from us. 

The program mutes the colors a little bit on the marked grid, due to this the coloring of the squares 
is not quite similar to the pure R, G, B.

Controls

· Slider changes the effect of the curves (by analogy with the layer transparency).
· The nodes can be moved with the help of mouse or using the arrows of the keyboard.
· Moving the mouse up/down and pressing Shift — to change the brightness of the nodes.
· Right-clicking or double-clicking — to reset the node.
· The nodes can be moved over the original image. Do not forget to pre-select one of three 

grids, right-clicking on the field.

Buttons

[Update Distribution] – update color distribution on the 2D curves after changing the grid in 
one of the curves.

[Pin all] – pin all nodes.

[Pin neutrals] – pin all neutral nodes.

[Proportional]* – separation of hue and brightness.

[Reset luma] – put the nodes in such way, that they change only colour but save the brightness.

[Smooth] – smooth the grids.

* The problem is that it is a projection, thus, at the bottom point there is not only black R0 G0 B0, 
but blue R0 G0 B255. At the upper point, there is not only white R255 G255 B255, but also yellow 
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R255 G255 B0. However, if in the image there are no so many primary colors, it is often a third 
color, which correlates with two visible. R and G increases moving up, but B stays, so the color 
becomes yellow. When it is moving down, respectively, it becomes blue. If you turn on the button 
Proportional, the program changes the blue channel proportionally to the change of red and green, 
and then vertically we simply get the brightness, and horizontally — the hue. It is similarly for other
pairs.
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Mask (color mask)

Masks allow changing the effect of all these 
tools, depending on the original colors. You 
should not forget, that the mask does not mean 
the mask on the image. The mask is applied 
only to the color. All the tools fall under the 
influence: curves, grids, mixers and even 
slider bar of white balance and contrast. 

A scheme in the lower part of the tab shows 
the procedure for correction applying, as well 
as the place of mask application. The currently 
active corrections are highlighted in white 
font. 

Mask curve

Horizontally, there is the value of the chosen component, such as point brightness. 
Vertically, there is the degree of mask effect. 

Masks examples

Full effect on the entire range: Complete lack of effect: Mask with a sudden drop:
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Controls

· You can put or move the points on the curve of effect with the help of left mouse button.
· You can remove the points from the curve with the help of right mouse button.
· The points of the curve can be moved with the help of arrows of the keyboard.
· The points can be set and moved using the original image.

Buttons
[Preview] turns on the viewing of the mask itself.
[Invert] inverts the mask.
[Randomize] – a random choice of the mask. There is put a random curve form of influence 
and the original mask component.
Switch Mask Method:

Fade – normal mode of mask effect. The smooth transition of RGB values between the 
original and toned images;
Limit – it limits the maximum color change, the curve mask value specifies the 
maximum rate of changes;
Fit – the curve sets the corridor around the toned variant. The higher the curve is, the 
narrower corridor is. If the colors of the original image are included in this corridor, they 
remain the same but if not then they are shifted to the toned.

In all three modes the curve position at the bottom means the original variant, and at the top 
– completely toned one. The modes affect only the intermediate values of the curve.

Switch Mask Destination determines when the mask is applied:
All – the mask is applied to the entire LUT correction;
Channel mixer – the mask is applied to the Channel mixer;
CM+Vol – the mask is applied to the Channel mixer and the volume;
CM+CL – the mask is applied to the Channel mixer and C/L grid;
CM+Curves – the mask is applied to the Channel mixer and Curves.

The moment of mask use is shown in the block-diagram under the mask.

The original mask component 

Red, Green, Blue1 – RGB channels of the original image.
CMYK channels – channels from CMYK space.
Luminance – the point brightness.
Hue – point hue.
Saturation – saturation.
Warmth – tint warmth. In the middle of the curve of neutral colour, at left - cool, at right -
warm.
LAB AB distance2 – the distance from the chosen hue of Lab space.
LAB LAB distance – the distance from the chosen hue of Lab space, taking into account the 
brightness.
HSPe AB distance – the distance from the chosen hue of HSPe space.
A HSP Sat – saturation in HSP color space.
A HSP Phase – phase in HSP color space.
RGB distance – the distance from the chosen color in RGB color space.
Difference – difference between program correction and original image.
HSP – HSP channels of the original image.
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1 – the basic data for the mask is always taken from the original image before applying the white 
balance and any other correction means.
2 – the color sample for distance is selected by the pipette. You can affect the distance between the 
colours with the help of curve.

External 3DLUT (External 3DLUT import)

Buttons
Load LUT – it allows you to select and load the external LUT file.
[<] [>] – to choose the next and previous LUT in the folder.
LUT Blend slider allows to adjust External 3DLUT effect.

External 3DLUT Mode:
Off – external LUT is not applied
Input – external LUT is applied before all the corrections
Output – external LUT is applied after all the corrections
Mask – external LUT is applied as a mask. The mask should be used in black and white 
LUT
Masked alt. – for the correction there is applied the program and the external LUT. The 
choice between one and the other is performed with the help of mask (black is for 
external LUT file white is for the program).

Master Section (Master)

It allows cutting or boosting the effect on the several LUT characteristics.

Range of influence:

Normal – all LUT;
Lighten, Darken – only lighten or darken.

Changing of the characteristics:

Blend – total force of influence (similar to the layer transparency);
Luminance – influence on the lightness;
Hue – influence on the hue;
Saturation – influence on the saturation.
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Image

On the screen there is shown one picture as the result 
of the correction. The original image can be viewed 
by clicking the middle mouse button. The image can 
be scaled using Ctrl(Cmd) +, Ctrl(Cmd) -. 

The enlarged image can be moved with the help of 
the middle mouse button or pressing the space bar.
You can move the grid nodes just clicking on the 
image and moving it with the help of mouse. In the 
same way you can change the brightness of the grid 
nodes, clicking and dragging the mouse and pressing
Shift. Clicking on the image and pressing Alt allows 
you to see the area of influence of a single color.

Hotkeys for the images

Ctrl(Cmd) + – zoom in.
Ctrl(Cmd) - – zoom out.
Ctrl(Cmd)+] – turn clockwise.
Ctrl(Cmd)+[ – turn counter clockwise.
Ctrl(Cmd)+0 – scale to fit the screen.
Ctrl(Cmd)+1 – original scale of the image.
C – enable/disable compare mode.
V – change the viewing layout (next to or above each other).
X – show the result and the original images together (divides the image in half).
W – for a picture divided in half, swaps the original image and the edited one.
/ – it switches to the original image if the comparison of the images is switched off (Compare).
J – show clipping the highlights and shadows.
Ctrl(Cmd)+3 Ctrl(Cmd)+4 Ctrl(Cmd)+5 – view of the separate RGB channels.
Ctrl(Cmd)+2 – disable viewing RGB channels.
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Color picker

Controls
It is possible to change the color dragging the mouse on the image. In the values window, the 
first row indicates the initial value, the second row – the new value for each color. Clicking on 
the window with numbers (any button) switches the display mode.

There are used the following colour spaces:
RGB – Red/Green/Blue – the absolute values;
RGB% – Red/Green/Blue – the percentage values;
LR LG LB – RGB in linear gamma.
HSV – Hue/Saturation/Value;
HSP – Hue/Saturation/ Perceived Brightness;
LAB
MAB
MXY
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Analyzer window
It shows the several tools for image analysis (F7)
Window→Analyzer.

Button

[Full] – whole image.
[Inside] – area in the mask.
[Outside] – area which is not in the mask.

Analysis tools

Historam (F8) – shown by default.

Waveform (F9) – shows the distribution of the values of red, green and blue channels with 
respect to the horizontal frame.

Vectorscope (F10) – shows the distribution of colours in YUV color space. By default, it is the 
top view. Right click on the Vectorscope shows a side view. With the left mouse button it can 
be rotated.
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Averages (F11) – averaged color plates.

The averages show the darkest color, average in brightness and 
the brightest colors of the image. Light, grey and dark averages 
are calculated from the image after its correction. There are 
also shown black, grey and white colors for comparison. The 
sample of grey color is calculated from the average image 

color. There are also shown the numeric values of the edited and sample colors. The mouse click 
switches the color model (see Colour picker).

Watches (замеры) (F12) – user color watches.

It allows adding user color watches. It shows the original, 
resulting colors as well as the numeric values. In order to 
add the sample there should be used the eyedropper on the 
top panel of the program. Using user watches you can 

move the nodes of C/L and A/B grids (by clicking and dragging the mouse). Clicking on the 
cross next to the plate closes it. Pressing the letter L shows the selected color on the grid.

Color Sort (Shift+F11) – sorting image pixels according to the brightness and displaying them 
in the form of a gradient.

Color circle (цветовой круг) (Shift+F12) – example. It shows the color wheel after using 
LUT-correction.
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Corrections applying order

Working with the program you should take into account that all the tools are applied to the image in 
the certain order. And the result of application of the single tool may depend on the result of 
application of the previous tools. 

In general the order of the tool application coincides with the order of tabs. The procedure is as 
follows:

1. Color balance sliders (Temp., Tint).
2. Channel mixer (Channels).
3. Channel volume (Volume).
4. A/B grid; Brightness/Contrast sliders.
5. Saturation slider.
6. C/L-grid.
7. Curves (can be applied before grids, button Before/After):

Luminance
Sat/Luma
Master curve
RGB curves

8. 2D Curves.
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Usage and Setup
LUT file

LUT (Look-Up Table) – a table of color matching.

LUT file is a cube in RGB space, i. e. a large cubic array. If you have specified the size of LUT
size = 25 you will have 25 values for each channel R, G or B. However, in the array there will be 
15625 (25*25*25) values where each element specifies a new color. In fact LUT is an image 
between two three-dimensional cubes. It has nothing similar to the curves with which it can be 
compared sometimes.

Lightroom
Lightroom does not support LUT tables. In order to start it the program should be set up as a plugin.

Menu Edit → Preferences, open the tab External Editing. Then in the field Additional External 
Editor change the settings:

Preset: we will return to it later
Application: click on Choose and specify the path to the folder with 3DLUTCreator.exe, click on .exe
File Format: TIFF
Color Space: sRGB (not necessarily, you can choose either)
Bit Depth: 16 bits/component
Resolution: 240
Compression: LZW
Check Stack With Original

Return to Preset, in the drop-down menu choose Save Current Settings as a New Preset, type in 
the window 3D LUT Creator, click the button Create. If you have done something incorrectly in 
the drop-down menu choose Delete Preset and repeat the procedure again.
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Work with the plugin in Lightroom

Photo → Edit In → 3D Lut Creator, choose the options - open on the copy or copies 
with the applied settings, Edit → Copy or Edit copy with Applied Settings. Open the 
program, apply the necessary actions. Pressing Ctrl(Cmd)+S and in a second the 
changes will be applied and shown in Lightroom. Close the program.

Video in Lightroom 
3D LUT Creator does not support video files, but let us consider the example of working with a 
single-frame. The settings for work as with a plugin are specified above.

First of all let's import a video to Lightroom:

· go to the tab Library → File (на маке - Lightroom) → Import Photos and
Videos;

· specify the path to the folder with this video;
· among the files in the preview choose the video which we want to import and 

click the button Import;
· stay in Library module as video files are not supported in Develop module!

Lightroom automatically creates a folder with video files in the left panel Collections → 
Smart Collections → Video Files, but in this case we do not use Smart Collections, 
and choose a video file from Folders! Now turn to the right panel in order to edit the 
color Quick Develop:

· you can apply the set preset in Lightroom;
· you can change White Balance, Tone Control, Exposure, Vibrance;
· Reset All is used in order to reset all the settings in the case if you have done 

something incorrectly;
· you can also specify the copyright information, etc.

Below the video file there is scrolling. You should choose the frame which we want to capture. On 
the right next to the time indicator there is a rectangle (it is highlighted in red in the preview), click 
it and choose the option Capture Frame, you create a file .jpeg.

Right-click on the preview → Edit In → 3D Lut Creator (or from menu Photo → Edit 
In → 3D Lut Creator). Choose the option Edit a Copy with Lightroom 
Adjustments or Edit a Copy. The program is opened. You can download a crosstab, 
apply the changes and use other program features. In order to return to Lightroom press 
the keys Ctrl(Cmd)+S, 3D LUT Creator can be closed. The final tweaking of the edited 
image is in Develop module if you need it. Then export the frame File → Export in the 
dropdown dialog specify where and how to save it.
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Photoshop
LUT is used in three ways:

· menu Image → Adjustments → Color Lookup;
· panel Layers: you can create an adjustment layer Color Lookup;
· panel Adjustments: you can create a layer with the help of Color Lookup.

  
Then in the layer features just choose the first point and upload the file. Do not forget to check
Dither. It provides antialiasing.

If you have used LUT within the action or saved an image with our adjustment layer in .psd format 
it is not necessary to save the original LUT file on disk. All the data for the edition are stored in the 
action itself or .psd file.
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Export

In Photoshop 2014 there is a new opportunity to save the processing in the form of 
LUT file. After that you can open this LUT with the help of 3D LUT Creator:

menu File → Export → Color Lookup Tables.

Video in Photoshop
Working process with a video file doesn't have any differences with the usual image 
processing. If you want to edit the grid just choose one of the frames. Put on the video 
the suitable frame and snatch it as with the help of [Get from Photoshop] button. When 
the work with the frame is finished it is possible to attach the adjustment layer with 
curves or LUT file to the video or make it directly (the changes will be applied to all the 
frames). In Photoshop the edited video is saved via the menu Image → Export Render 
→ Video.

Quick opening of a single frame of After Effects

· Download the plugin Comp2Clip2 from Video Copilot, it's free
www.videocopilot.net/blog/wp-content/uploads/2010/11/Comp2Clip2.zip

· Unpack the archive. The installation is performed in accordance with the bit count 
system (x32 or x64) - .aex for windows and .plugin for mac to the folder with 
plugins to AE, for example, I have: C:\Program Files\Adobe\Adobe After Effects 
CC\Support Files\Plug-ins\Comp2Clip

· Run After Effects and 3D LUT Creator.
· Upload the video into After Effects, create a new layer and choose the desired 

frame.
· File → Export → Copy Frame to Clipboard (see Picture).
· Go to 3D LUT Creator and in the tab Transform click on the button Paste. The 

frame is ready for processing and LUT creation.
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Full list of hotkeys
Ctrl(Cmd)+N – reset all image settings
Ctrl(Cmd)+O – open image
Ctrl(Cmd)+S – save image
Ctrl(Cmd)+Shift+S – save edited image with a new name
Ctrl(Cmd)+E – save LUT file
Ctrl(Cmd)+I – get image from Photoshop
Ctrl(Cmd)+P – send LUT to Photoshop
Ctrl(Cmd)+W – swap current and external LUT
Ctrl(Cmd)+Z – undo last action

Alt+1 – edit lightness curve
Alt+2 – edit master curve
Alt+3, Alt+4, Alt+5 – edit one of RGB curves
Ctrl(Cmd)+R – make random RGB curves

Ctrl(Cmd)+A – select all grid nodes
Ctrl(Cmd)+D – unselect all grid nodes
Ctrl(Cmd)+F – pin all grid nodes
S – enable/disable showing original colors on grid (show node tails)

Ctrl(Cmd) + – zoom in
Ctrl(Cmd) – – zoom out
Ctrl(Cmd)+[ – turn image clockwise
Ctrl(Cmd)+] – turn image counter clockwise
Ctrl(Cmd)+0 – fit screen
Ctrl(Cmd)+1 – original image size
C – enable/disable before and after images view
V – change the viewing layout (before/after next to or above each other)
X – split view to show before/after images together (divides the image in half)
W – for split view swaps the original image and the edited one
\ – switches to the original image if the comparison of the images is switched off (Compare)
Ctrl(Cmd)+3, Ctrl(Cmd)+4, Ctrl(Cmd)+5 – view of the several RGB channels
Ctrl(Cmd)+2 – disable viewing RGB channels

J – show highlights and shadows clipping
F6 – enables/disables the color display in A/B, C/L grid
P – switch the number model in order to change the color picker (Color picker)

F7 – open Analyzer window
F8 – Historam
F9 – Waveform
F10 – Vectorscope
F11 – Averages (averaged colour plates)
F12 – Watches (colour watches)
Alt+F11 – Color sort
Alt+F12 – Color circle
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Compatibility
The program is available for Windows and OS X. This is a different license and they 
are sold separately.

Supported versions of Microsoft Windows:
Windows XP 32/64-bit
Windows Vista 32/64-bit
Windows 7 32/64-bit
Windows 8 32/64-bit

Supported versions of OS X:
Mac OS X 10.5.5–10.10 Yosemite

Update

To update the program go to your personal account at 
http://3dlutcreator.com/user.php. Generate a program distribution and download it. 
This will be an updated version of the program. Re-activation is not required.


